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MSTC LIMITED 

 
(A GOVERNMENT OF INDIA ENTERPRISE) 

MSTC head office, 225-C, A.J.C Bose Road, Kolkata-700 020. 

CIN : L27320WB1964GOI026211 
 

 

NOTICE INVITING TENDER (NIT) 

for 

EMPANELMENT AND SELECTION OF GST AUDITOR FOR FY 2019-20 
 

 

Event no. MSTC/Head Office/Finance and Accounts/1/20-21/ET/23 

[EMPANELMENT FOR GST AUDITOR] 
FILE TENDER NO.: MSTC/FnA/GST Audit/FY 19-20/1 Dated: 11.01.2021 

 

 

 

 
E-Tender under single stage two-part system (Part I: Techno-Commercial Bid and Part II: 

Price Bid) are invited from reliable, bona fide & experienced entity for Empanelment and 

Selection of GST Auditor for Financial Year 2019-20 for 18 GSTIN in 17 states. 
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SCHEDULE OF TENDER (SOT) 
 

1. E-TENDER No./EVENT No. MSTC/Head Office/Finance and Accounts/1/20-

21/ET/23 

2. MODE OF TENDER Open and e-Tender System 

Online submission of Part I - Techno-

Commercial Bid and Part II - Price Bid through 

https://www.mstcecommerce.com/eproc of MSTC 

Ltd.. The intending tenderers are required to submit 

their offer electronically through this e-tendering 

portal. No physical tender is acceptable by 

MSTC 

3. 

 

Date of publication of e-Tender through 

publication in MSTC websites and Central 

Public Procurement Portal   

11-January-2021 at 1500 Hrs (IST) 

 

4. Date of availability of NIT to the Vendors for 

downloading 

11-January-2021 at 1600 Hrs (IST) 

5. Date of Starting of e-Tender for submission of 

Online Techno-Commercial Bid and Price Bid 

at  www.mstcecommerce.com/eproc 

12-January-2021 at 1100 Hrs (IST) 

6. Date of closing of Online e-tender for 

submission of Techno-Commercial Bid & 

Price Bid at  www.mstcecommerce.com/eproc 

10-February-2021 at 1100 Hrs (IST) 

7. Date & time of opening of Part-I (Techno-

Commercial Bid) 

10-February-2021 at 1200 Hrs (IST) 

8. Date & time of opening of Part-II (Price Bid ) To be communicated separately to qualified 

Tenderers. 

 

Note 1: In the event of any unforeseen closure of work / holiday on any of the above days, the same will 

be opened / held on the next working day without any further notice. 

Note 2: The details of the tender document are available at MSTC’s websites www.mstcindia.co.in and 

also on e-procurement portal of GOI http://eprocure.gov.in/cppp. The corrigendum / addendum to this 

tender, if any, shall also be uploaded on the above websites. 
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SECTION 1 : NOTICE INVITING BID 
 
 
1.1. Introduction 

 

About MSTC: 

MSTC Limited is a Mini Ratna Category-I PSU under the administrative control of the Ministry of Steel, 

Government of India. The company was set up in 9th September 1964 to regulate export of surplus ferrous 

scrap in the early 1970’s due to growth of scrap using Industries in India, scrap becomes a deficit item and 

role of MSTC was redefined as that of a canalizing agency for import of ferrous scrap. 

From being a small canalized agency, MSTC has emerged as a major player in the country for promoting e-

Commerce and Trading. It has developed and utilized an immensely popular tool for transacting business 

over the internet in a most transparent and fair manner by its e-Auction portal 

namely, www.mstcecommerce.com . This portal provides a virtual marketplace for domestic sellers and 

buyers to do business in metal scrap (ferrous/non-ferrous), surplus stores, machineries, obsolete spares, 

vehicles, minerals and agriculture & forest produce etc. The methodology adopted includes open tender, 

public auction and e-auction. It has also developed an e-Procurement portal and is ready with end-to-end e-

Procurement services.  

The company has its Registered & Corporate Office at Kolkata with 4 Regional Offices (RO) at Kolkata, 

New Delhi, Mumbai & Chennai and 13 Branch Offices (BO) at Bangalore, Vizag, Vadodra, Hyderabad, 

Bhopal, Bhubaneshwar, Chandigarh, Guwahati, Jaipur, Lucknow, Raipur, Ranchi & Trivandrum). All the 

Offices are maintaining books of accounts at their respective locations in in-house accounting software 

ISTMS. 

The details of the company are available on website www.mstcindia.co.in.  

1.2.  Invitation to Tenderers 
 
E-Tender under single stage two-part system (Part I: Techno-Commercial Bid and Part II: Price Bid) are 

invited from reliable, bona fide & experienced entity for Empanelment and Selection of GST Auditor for 

Financial Year 2019-20 for its 18 registrations in 17 States with an option to extend the contract for audit of 

one more year on the same rate, terms & conditions by mutual consent. 

 

I. The Tender Document can be downloaded from the website of MSTC/CPP. 

II. MSTC may, at its own discretion, extend the date for submission of proposals. 
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SECTION 2 : IMPORTANT INSTRUCTIONS FOR E-PROCUREMENT 

This is an e-procurement event of MSTC LIMITED.   

 

The e-procurement service provider is MSTC Ltd., 225C, A.J.C. Bose Road, Kolkata-700 020.You are 

requested to read the terms & conditions of this tender before submitting your online tender. Tenderers who 

do not comply with the conditions with documentary proof (wherever required) will not qualify in the Tender 

for opening of price bid 

 

1. A. Process of E-tender:  

Registration: The process involves Tenderer’s registration with MSTC e-procurement portal which is 

free of cost. Only after registration, the Tenderer(s) can submit their bids electronically. Electronic 

Bidding for submission of Techno-Commercial Bid as well as Price Bid will be done over the internet.  

REQUIREMENT OF VENDOR : 

i. The Tenderer should possess Class III signing type digital certificate. (Bids will not be 

recorded without Digital Signature). 

ii. Tenderers are to make their own arrangement for bidding from a Computer connected with 

Internet.  MSTC is not responsible for making such arrangement  

iii. Registration with portal www.mstcecommerce.com/eproc 

SPECIAL NOTE: THE PRICE BID AND THE TECHNO-COMMERCIAL BID HAS TO BE 

SUBMITTED ON-LINE AT https://www.mstcecommerce.com/eproc 

Tenderers are required   to register themselves online with www.mstcecommerce.com → e-

Procurement → Common Portal → Register as Vendor by filling up details and creating own user id 

and password → Submit. 

Tenderer will receive a system generated mail confirming their registration in their email which has 

been provided during filling the registration form. 

In case of any clarification, tenderers are requested to contact MSTC, (before the scheduled closing 

time of the e- tender).  

B. Contact person (MSTC):  

1. Ms. Neha Bansal, Manager (F&A), Mobile: 8527333183, email: nbansal@mstcindia.co.in 

2. Shri Nuthi Harish Babu, AM(F&A), Mobile No.: 8660501168, email:  

nhbabu@mstcindia.co.in 

For Technical Help: Contact 033-22901004  

C. System Requirement: 

a) Operating System –Windows 7 and above  

b) Web Browser- Preferred ‘IE 8’ and above 

c) Signing type Digital Signature Certificate (DSC) 

d) Security Settings :  

i) To disable “Protected Mode” for DSC to appear in the signer box : 

Tools=>Internet Options=>Security=>Disable protected Mode If enabled-i.e., Remove 

the tick from the box mentioning “Enable Protected Mode”.  

ii) Tools => Internet Options => Security =>Custom Level=>  

• Active X control & plug-ins: Enable all ActiveX Controls  

• Scripting: Enable “Allow Status Bar Update Via Script”  
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• Disable “Use Pop-up Blocker”  

      d) Java: Install latest updated JRE 8 (x86 Offline) software 

e) Other Settings: 

• View => Toolbars=> “Tick” Status Bar. 

• Tools => Internet Options => General => Click On Settings under “browsing history/ 

Delete Browsing History” => Temporary Internet Files => Activate “Every time I Visit the 

Webpage”. 

• To enable ALL active X controls  and disable ‘use pop up blocker’ under Tools→Internet 

Options→ custom level (Please run IE settings from the page www.mstcecommerce.com 

once) 

• For new Version of IE or other “Active –X Filtering” under Tools should not be ticked.  

• Tools =>Internet Options=> Security=> Selected Trusted Sites=> Add Website 

https://www.mstcecommerce.com. 

2. (A) Part I Techno-Commercial bid will be opened electronically on specified date and time as given in 

the NIT.  

(B) Part II Price bid will be opened electronically of only those Tenderer(s) whose Part I Techno-

Commercial Bid is found to be Techno-Commercially acceptable to MSTC. Such Tenderers will be 

intimated date of opening of Part II Price bid, through valid email confirmed by them. 

Note: 

The Tenderers are advised to offer their best possible rates.  There would generally be no negotiations 

hence may submit their most competitive prices while submitting the price bid.  

3. All entries in the tender document should be entered in online Technical & Commercial Formats 

without any ambiguity. 

4. Special Note towards Transaction fee: Not Applicable 

5. All notices and correspondence to the Tenderer(s) shall be sent by email only during the process till 

finalization of tender by MSTC. Hence the Tenderers are required to ensure that their corporate email 

I.D. provided is valid and updated at the stage of registration of Tenderer with MSTC (i.e. Service 

Provider). Tenderers are also requested to ensure validity of their DSC (Digital Signature Certificate). 

6. a) Please note that there is no provision to take out the list of parties downloading the tender document 

from the web site mentioned in NIT.  As such, Tenderers are requested to see the web site once 

again before the due date of tender opening to ensure that they have not missed any corrigendum 

uploaded against the said tender after downloading the tender document. The responsibility of 

downloading the related corrigenda, if any, will be that of the tender document downloading 

parties. 
b) No separate intimation in respect of corrigendum to this NIT (if any) will be sent to Tenderer(s) who 

have downloaded the documents from the web site. Please see website 

https://www.mstcecommerce.com/eproc of MSTC Ltd. 

7. E-tender cannot be accessed after the due date and time mentioned in NIT. 

8. Bidding in e-tender: 

Tenderer(s) need to submit necessary EMD (If any), Tender fees (If any) and Transaction fees (if any) 

to be eligible to bid online in the e-tender. Tender fees and Transaction fees are non-refundable. No 

interest will be paid on EMD. EMD of the unsuccessful Tenderer(s) will be refunded by MSTC.  

a) The process involves Electronic Bidding for submission of Techno Commercial Bid as well as 

Price Bid. 

b) The Tenderer(s) who have submitted the transaction fees (if any) can only submit their Techno 
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Commercial Bids and Price Bid through internet in MSTC website 

www.mstcecommerce.com/eproc.  The NIT/ Documents shall be available for download in the 

event catalogue available under ‘Event Details’ of ‘Event’. 

c) The tenderer should allow running JAVA application by accepting the risk and clicking on run. 

This exercise has to be done twice immediately after clicking on the Techno-Commercial bid. 

If this application is not run, then the Tenderer will not be able to save/ submit his bid. 

d) After filling the Techno-Commercial Bid, tenderer should click ‘save’ for recording their 

Techno-Commercial bid. Once the same is done, the Price Bid link becomes active and the 

same has to filled up and then Tenderer should click on “save” to record their price bid. Then 

once both the Techno-Commercial bid & price bid has been saved, the Tenderer can click on 

the “Submit” button to register their bid . 

NOTE: - The Techno-Commercial Bid & price bid cannot be revised once the submit button 

has been clicked by the Tenderer. 

e) The tenderers are instructed to use Attach Doc button to upload documents. Multiple 

documents can be uploaded.  

f) In all cases, Tenderer should use their own ID and Password along with Digital Signature at the 

time of submission of their bid. 

g) During the entire e-tender process, the Tenderers will remain completely anonymous to one 

another and also to everybody else. 

h) The e-tender floor shall remain open from the pre-announced date & time and for as much 

duration as mentioned in Schedule of Tender (SOT).  

i) All electronic bids submitted during the e-tender process shall be legally binding on the 

Tenderer. Any bid will be considered as the valid bid offered by that Tenderer and acceptance 

of the same by MSTC will form a binding contract between MSTC and the Tenderer for 

execution of work.  

j) It is mandatory that all the bids are submitted with digital signature certificate otherwise the 

same will not be accepted by the system.  

k) MSTC reserves the right to cancel or reject or accept or withdraw or extend the tender in full or 

part as the case may be without assigning any reason thereof.  

l) No deviation in the terms and conditions of the tender document is acceptable. Submission of 

bid in the e-tender floor by any tenderer confirms his acceptance of terms & conditions for the 

tender. 

m) Rate to be quoted should be in Indian Rupees. 

9. Any order/contact resulting from this open e-tender shall be governed by the terms and conditions 

mentioned in NIT. 

10. No deviation to the technical and commercial terms & conditions is allowed. 

11. MSTC has the right to cancel this e-tender or extend the due date of receipt of bid(s) without assigning 

any reason thereof. 

12. The online tender should be submitted strictly as per the terms and conditions and procedures laid down 

in the website https://www.mstcecommerce.com/eproc of MSTC Ltd.   

13. The Tenderers must upload all the documents required as per terms of NIT.  Any other document 

uploaded which is not required as per the terms of the NIT shall not be considered. 

14. The bid will be evaluated based on the filled-in techno-commercial and price formats. 

15. Vendors are requested to read the vendor guide and see the video in the page 

ww.mstcecommerce.com/eproc  to familiarize them with the system before bidding. 
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SECTION 3: COMMERCIAL TERMS AND CONDITIONS 
 

3.1.  Concurrence and remarks for all Commercial Terms & Conditions will be taken Online. Upload 

supporting documents wherever necessary. No hardcopy for the same needs to be submitted. If required, the 

Tenderer(s) may be asked to produce the Original documents before the Tender Committee for verification 

purpose only. 

 

3.2.       The Schedule of Tender (SOT), Important Instructions for e-procurement, Commercial Terms 

and Conditions and General Terms and Conditions all taken together shall constitute the contract between 

MSTC and Tenderer.  

 

 

3.3. Integrity Pact 

 
This tender will be governed by the Integrity Pact as available in MSTC’s website www.mstcindia.co.in 

which may be downloaded if necessary and all contracts and transactions arising out of this tender shall be 

governed amongst other terms by the terms of the said Integrity Pact.  

Successful Tenderer shall sign Integrity Pact with MSTC at the time of awarding the contract. (Annexure II) 

 

3.4. Earnest Money Deposit (EMD) 

 
No EMD is required for submission of the Tender Documents 

 

3.5. SCOPE OF WORK 
 

a. As per the requirement of GST Act, MSTC desires engagement of a qualified and experience appoint 

CA or CMA or CA/CMA Firms/LLPs to carry out GST Audit under section 35 (5) of CGST Act, 2017 read 

with Rule 80 of CGST Rules, 2017, as amended from time to time, for all Principal Place of Business and 

Additional Place of Business and to issue separate Audit Report / Certificate/ Statement in adherence to the 

relevant orders/clarification issued/prescribed under GST Act for its 18 registrations in 17 States. 

b. Audit activities are to be carried out for compliance under GST for all offices designated as Principal 

Place of Business as well as Additional Place of Business (if any) for following 18 GST Registrations of 

MSTC Limited: 

S. No. States / UT GSTIN 

1 West Bengal 19AACCM0021E1Z4 

2 West Bengal 19AACCM0021E2Z3 

3 Delhi 07AACCM0021E1Z9 

4 Maharashtra 27AACCM0021E1Z7 

5 Tamil Nadu 33AACCM0021E1ZE 

6 Karnataka 29AACCM0021E1Z3 

7 Andhra Pradesh 37AACCM0021E1Z6 

8 Gujarat 24AACCM0021E1ZD 
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9 Madhya Pradesh 23AACCM0021E1ZF 

10 Telangana 36AACCM0021E1Z8 

11 Uttar Pradesh 09AACCM0021E1Z5 

12 Odisha 21AACCM0021E1ZJ 

13 Kerala 32AACCM0021E1ZG 

14 Chhattisgarh 22AACCM0021E1ZH 

15 Rajasthan 08AACCM0021E1Z7 

16 Jharkhand 20AACCM0021E1ZL 

17 Assam 18AACCM0021E1Z6 

18 Haryana 06AACCM0021E1ZB 

 

c. The entire audit activities are to be carried out from MSTC’s Head Office at Kolkata, West Bengal. 

d. The auditor is required to carry out the GST audit for the FY 2019-20.  

e. The auditor is responsible for issuing and E-filling of GST Audit Report along with Annual Return 

(GSTR-9) and Reconciliation Statement as per section 44(2) of the CGST Act, 2017 in E-form GSTR-9C or 

any other format that may be notified from time to time within the scheduled due date and in the manner as 

specified/prescribed by CBIC/GOI.  

f. The Auditor will be required to issue Audit Report, Certificate for each unit separately as per the 

requirements of the GST Act & Rules. 

g. All formats as required by statute are to be certified by auditor in the prescribed manner. 

h. In connection with above audit, guidelines issued by Institute of Chartered Accountants of India 

and/or Institute of Cost Accountants of India, if any shall also be followed by the auditors to have uniformity 

across the Company. 

i. GST Audit Team shall consist of adequate number of qualified/semi-qualified assistants (CA/CMA) 

led by a qualified CA or CMA or partner of CA/CMA Firms/LLPs. 

 

3.6. ELIGIBILITY CRITERIA 

 

a. The Tenderer should be a practicing member of Institute of Chartered Accountants of India or 

Institute of Cost Accountants of India for a period of at least 5 (five) years. In the case of firms, it should be 

registered with the Institute of Chartered Accountants of India or Institute of Cost Accountants of India in 

existence for a minimum period of 5 (five) years. 

Note : The cut-off date will be 31.12.2020 with respect to eligibility criteria for 5 years’ experience. Fraction 

of the year will not be considered in above selection criteria. 

b. Tenderer should have at least one functional office in the Kolkata region, since entire audit activities 

are to be carried out from MSTC’s Head Office at Kolkata (West Bengal). 

 

c.  Experience of CA or CMA or CA/CMA Firms/LLPs in GST Audit of for the Financial Year 2017-

18 or FY 2018-19 of at least one  

 

- Listed Company or 
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- Public Sector Undertaking (PSU) or 

- any other company having annual turnover of Rs. 500 Cr and above  

 

d. The tenderer must be having a valid GST Registration as regular taxpayer. 

 

e. The tenderer should have never been blacklisted and / or there were no debarring actions against the 

tenderer for any default or in the performance of the contract entrusted to the tenderer in any of the 

Government Departments/ Central and State Public Sector Enterprises/ Autonomous Bodies. 

 

 

3.7. Conflict of interest 

 
a. The selected CA or CMA or CA/CMA Firms/LLPs should provide professional, objective and 

impartial service and hold MSTC’s interest paramount. 

b. The selected Firm shall not deploy former employees who have served MSTC in last six months. 

c. The selected Firm shall not downstream or outsource any part of the scope of work.  

d. Non-disclosure of such an association will lead to termination of Agency. 

 

3.8. Validity of Proposal 

 
The following will be considered for the validity of the proposals deemed submitted: 

 

a. Proposals shall remain valid for a period of 60 days from the date of opening of Price Bid. 

b. MSTC reserves the right to reject a proposal valid for a shorter period as non- responsive. 

c. In exceptional circumstances MSTC may solicit the Tenderer’s consent to an extension of the period 

of validity. The request and the response thereto shall be made in writing 

 
3.9. Right to Accept or Reject any Proposal 

 

MSTC reserves the right to annul the Tender process, or to accept or reject any or all the proposals in whole 

or part at any time without assigning any reasons and without incurring any liability to the affected Bidder(s) 

or any obligation to inform the affected Tenderer(s) of the grounds for such decision. 

 

 

3.10. Preparation and Submission of Proposal 
 

The Tenderer must comply with the following instructions during preparation of Proposals: 

 

a. The Tenderer is expected to carefully examine all the instructions, guidelines, terms and condition 

and formats of the Tender Document. Failure to furnish all the necessary information as required by 

the Tender Document or submission of a proposal not substantially responsive to all the requirements 

of the Tender Document shall be at Tenderer’s own risk and may be liable for rejection. 

b. The Proposal and all associated correspondence shall be written in English and shall be in a clear and 

legible language.  

c. No Tenderer is allowed to modify, substitute, or withdraw the Proposal after its submission. 

 

The Tenderer shall submit Technical & Price Bid in two parts as per details below: 

 

PART-I: TECHNO-COMMERCIAL BID 

PART-II: PRICE BID 

 

PART- I: Techno-Commercial Bid 
a. Techno-Commercial Bid shall be submitted in electronic mode only through MSTC E-Tendering 

portal https://mstc.mstcecommerce.com/eproc in format provided at the time of bidding. 
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b. All the documents mentioned in Section 5 of the tender document must be in the order and duly 

signed, stamped and uploaded. All documents of the bid shall be signed by CA or CMA or 

Partner/Member of CA/CMA Firms/LLPs with seal and membership number. Any consequences 

resulting due to such signing shall be binding on the Tenderer. 

c. Each page should be page numbered and conformance to the eligibility qualifications should be 

clearly indicated. The proposals should not contain any irrelevant or superfluous documents. 

d. The Technical Proposal must not include any financial information regarding the Price which has to 

be submitted separately, failing which the Proposal will be rejected. 

 

PART – II: Price Bid 

 
a. The Price Bid shall be submitted in electronic mode only through MSTC E-Tendering portal 

https://mstc.mstcecommerce.com/eproc in format provided at the time of bidding  

b. Document. Class III Digital Signature Certificate (DSC) is mandatory to participate in e-tendering. 

Participating tenderers have to make sure that they have the valid DSC in their name. 

c. Tenderers are advised to exercise greatest care in entering the Price Bid figure. No requests regarding 

correction of mistakes in the financial bids will be entertained once the same has been submitted. 

d. Tenderer shall quote the price after careful analysis of cost involved for the performance of the 

complete work considering all parts of the Tender Document.  

e. The quoted Price shall be Consolidated GST Audit Fees for 18 GST Registrations of MSTC 

Limited for Financial Year 2019-20 and deemed to be all inclusive except applicable GST. It is 

clearly understood that MSTC will not have any additional liability towards payment of any Taxes & 

Duties except applicable GST leviable on total quoted price.  

f. Alternative / conditional bids shall not be considered.  

g. Prices quoted by the Tenderer, shall remain firm and fixed and valid until completion of the Contract 

and will not be subject to variation on any account.  

h. Price shall be quoted in figures in Indian Rupees. 

 

3.11. Bid Opening 

 

a. PART – I : TECHNO-COMMERCIAL BID : MSTC will open the technical bids electronically at 

date & time as stipulated in Schedule of Tender. Tenderer(s) can witness electronic opening of bid. 

b. PART – II : PRICE BID : Price bid of only those tenderers whose bids are determined to be 

technically qualified shall be opened. Tenderers selected for opening of their price bids shall be 

informed about the date of price bid opening.  

 

 

3.12. Evaluation of Technical bids 

 
The Technical bid submission and its evaluation shall be based on the parameters are as mentioned in the 

Table below. 

 

S. No. Particulars Details (supporting  

documents, wherever 

applicable are required to 

be uploaded) 

1. Name of the CA or CMA or CA/CMA Firms/LLPs  

2. Firm Registration Number, if applicable  

3. Registered Address with PIN Code  

4. Name of Authorized Person to submit the bid  

5. Designation of Authorized Person Partner / Sole Proprietor 

6. Membership number of Authorized Person  
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7. Contact no. (Mobile)  

8. Contact no. (Landline) if any  

9. Contact no. (FAX) , if any  

10. Email Address  

11. Website, if any  

12. Office Address in Kolkata with PIN Code (Copy of document to 

establish that office premise is either on owner ship or rent basis in 

Kolkata to be attached) (Rent Agreement / Electricity Bill) 

 

13. Date of Registration of Partnership Firm/LLP (Experience of 5 

years till 31.12.2020 required) (Proof of registration to be attached 

clearly indicating the Registration date and firm registration 

number issued by Institute of Chartered Accountants of India or 

Institute of Cost Accountants of India) 

Mention date of Registration 

of Partnership Firm/LLP 

14. Partnership Deed or communication from ICAI or other evidence 

clearly indicating the partners in the firm with their membership 

number and date from which they are with the firm to be attached 

Applicable / Not Applicable 

15. Effective date of issue of Certificate of Practice (full time) for 

experience of CA or CMA in case of sole proprietorship. 

(Attached proof) 

Mention date of issue of COP 

16. Experience of CA or CMA or CA/CMA Firms/LLPs in GST Audit 

of for the Financial Year 2017-18 or FY 2018-19 of at least one  

- Listed Company or 

- Public Sector Undertaking (PSU) or 

- any other company having annual turnover of Rs. 500 Cr 

and above. Copy of appointment / Engagement letter to be 

attached. 

Mention name of the 

company(s) and year of GST 

audit already conducted 

17. GST Registration Number  

(Copy of GST Registration Certificate in Form GST REG-06 to be 

attached) 

GSTIN to be entered 

18. PAN of CA or CMA in case of proprietorship or of Firms/LLPs 

(Copy of PAN card to be attached) 

PAN to be entered 

19. Bank Mandate form and cancelled cheque for remittance of 

payment though NEFT/RTGS to be attached 

Agree/Not Agree 

20. All Commercial and General Terms and conditions as mentioned 

in the tender documents are acceptable to the Tenderer 

Agree 

21. Letter of Undertaking as mentioned in Annexure I to be uploaded Agree 

22. Terms in Integrity Pact as per Annexure II agreed by the Tenderer 

(will be signed by successful bidder later) 

Agree 

 

Further  

a. The MSTC will determine whether each of the bids conforms to the terms, conditions and 

specification of the Tender Document without material deviation and is complete with regard to 

submission of required documents. A material deviation is one which affects in any substantial way 

the scope, quality or performance of the works, or which limits in any substantial way, inconsistent 

with the Tender Document, the MSTC’s rights or the Tenderer’s obligations as envisaged in the 

Tender Document, and the rectification of which deviation or reservation would affect unfairly the 

competitive position of other Tenderers presenting substantially responsive Bids. 

b. No stipulation, deviation, terms & conditions, presumption, basis etc. shall be stipulated in the bid. 

Any conditions, if stipulated, shall be treated as null and void and may render the bid liable for 

rejection. 

c. MSTC, if necessary, will obtain clarifications on the Bid by requesting for such information / 

clarifications from any or all Tenderers, either in writing or through personal contact. Such 

information has to be supplied within the set out time-frame, otherwise the Evaluation Committee 

shall make its own reasonable assumptions at the total risk and cost of the Tenderers and the 
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Proposal is liable to be rejected. Seeking clarifications cannot be treated as acceptance of the 

proposal. All responses shall be in writing, and no change in the price or substance of the bid shall be 

permitted unless specifically sought by MSTC. MSTC reserve the right to assess Tenderer’s 

capability and capacity to execute the work using in-house information including taking into account 

other aspects such as concurrent commitments, past performance etc. 

d. For verification of information submitted by the, the Tender Committee may visit Tenderer’s offices 

at its own cost. The Tenderers shall provide all the necessary documents, samples and reference 

information as desired by the Committee. The Tenderers shall also assist the Committee in getting 

relevant information from the Tenderers references, if desired. 

 

3.13. Price Bid Evaluation 
 

a. Financial proposals of only those tenderers who are technically qualified shall be opened on the date 

& time specified in the Schedule of Tender. 

b. Lowest Overall Evaluation will be done on the basis of total quoted price.  

c. Tenderer quoting lowest as at (a) above and adhering to tender stipulations in an unqualified manner 

shall be recognized as L-1. 

 

 

3.14. Notification of award 
 

MSTC will issue the Letter of Award (LOA) to the successful Tenderer and communicate the same through 

Courier/Fax/email as per details given by Tenderer. The said communication will constitute acceptance to the 

proposal of the shortlisted tenderer on behalf of MSTC. 

 

 

3.15. Contract Duration 
 

The contract along with quoted consolidated price will be valid for GST Audit for 18 GST Registrations of 

MSTC Limited in 17 states for Financial Year 2019-20. The contract may, however, be extended further for 

GST audit for one more financial year with same terms and scope of work as specified in this tender 

document, thereafter, subject to satisfactory execution of job(s) and at sole discretion of MSTC. 

 

 

3.16. Completion of work 
 

The work should be completed well within the scheduled due date and in the manner as specified/prescribed 

by CBIC/GOI. 

 

  

3.17. Payment Terms 

 
The payment will be released by MSTC Limited as per the following payment terms: 

a. Necessary payments in relation to the Audit assignment shall be made on completion of the audit for 

all 18 GST registrations of MSTC in accordance with the provisions of the GST Act and to the 

satisfaction of the MSTC. 

b. After successful completion of audit of Financial Year 2019-20, the audit firm will submit the 

invoice in triplicate duly signed by the Authorized person. The invoice will be in the name MSTC 

Limited with MSTC’s GSTIN. 

c. Payment will be made within 30 days from the date of receipt of the invoice, after deducting 

TDS/any other tax/levy as per prevailing rules/rates. 

 

 

3.18. T.A. & D.A. 
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The rates quoted by you shall be inclusive of T.A. & D.A. or out of pocket expenses, if any. No payment 

shall be admissible in connection with the preparation and submission of the offer and to bear any further 

pre-contract costs or during completion of job. Since the entire audit activities are to be carried out from 

MSTC's Head Office at Kolkata, West Bengal, hence travelling, boarding & lodging expenses or any other 

expense shall not be payable by MSTC Limited. 

 

 

  



Page 15 of 23 

TENDER NO.: MSTC/FnA/GST Audit/FY 19-20/1 

SECTION 4 : GENERAL TERMS AND CONDITIONS 

 
4.1.Fraud & Corruption 

 

It is required that the tenderers submitting Proposal and tenderer selected through this Tender Document 

must observe the highest standards of ethics during the process of selection and during the performance 

and execution of the Work Order. 

 

For this purpose, definitions of the terms are set forth as follows: 

 

 

a. "Corrupt practice" means the offering, giving, receiving or soliciting of anything of value to 

influence the action of MSTC or its personnel in Work Order executions. 

b. "Fraudulent practice” means a misrepresentation of facts, in order to influence the selection process 

or the execution of a Work Order, and includes collusive practice among Tenderers (prior to or after 

Proposal submission) designed to establish Proposal prices at artificially high or non-competitive 

levels and to deprive MSTC of the benefits of free and open competition. 

c. “Unfair trade practice” means supply of services different from what is ordered on, or change in the 

Scope of Work. 

d. “Coercive practice” means harming or threatening to harm, directly or indirectly, persons or their 

property to influence their participation in the selection process or execution of the Work Order. 

e. MSTC will reject a proposal for award, if it determines that the Tenderer recommended for award, 

has been determined to having been engaged in corrupt, fraudulent or unfair trade practices. 

f. MSTC will declare a Firm ineligible, either indefinitely or for a stated period of time, for awarding 

the Work Order, if it at any time determines   that Firm has engaged in corrupt, fraudulent and 

unfair trade practice in competing for, or in executing the Work Order. 

 

4.2. Clarifications & Amendments of Tender Document 
 

a. Bidders are requested to visit our website regularly for any 

amendment/addendum/corrigendum/extension until last date. 

b. AMENDMENT OF TENDER DOCUMENTS: 

i. MSTC may for any reason, modify the Tender Document from time to time.  

ii. At any time prior to the deadline for submission of tenders, MSTC for any reason whether at 

their own initiative or in response to a clarification required by any prospective Tenderers may 

modify the Tender Documents. 

iii. The amendment shall be part of the Tender Documents and will be notified by publication in the 

MSTC’s / Central Public Procurement Portal and will be binding on the prospective Tenderers. 

iv. All the intending Tenderers are advised to keep close watch on the website of MSTC / CPP 

Portal in their own interest. 

v. The amendment(s) to the Tender Document would be clearly spelt out and the Tenderers may be 

asked to amend their proposal due to such amendments. 

c. During the process of evaluation of Proposals, MSTC may, at its discretion, ask Tenderers for 

clarifications on their proposal.  The Tenderers are required to respond within the prescribed time-frame. 

 

 

4.3.Risk Purchase 
 

 

In the event, the successful tenderer fails to execute the work order, MSTC reserves the right to get the 

same executed through some other source and the extra cost thereof including the duties and taxes shall be 
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recoverable from the successful tenderer. Your offer shall be rejected if this Risk Purchase clause is not 

accepted. 

 

 

4.4. Sub-contracting of work order 

 
The GST Audit Firm shall not sub-contract/assign/ outsource the GST audit work and Audit team will 

work in strict confidence and will ensure that the data, information in respect of the company is dealt 

within strict confidence and secrecy.  

 

4.5.Neither the CA, CMA, firm nor its partner or Associates should have any interest in the business of 

MSTC. 

 

4.6.The interested Tenderers have to submit their offer strictly in the Performa along with relevant documents 

in support.  

 

4.7.Acknowledgement by Tenderer: 
 

By submitting a quotation/bid, the Tenderer shall be deemed to have fully familiarized himself/themselves 

with  

a. The requirement of the job to be undertaken. 

b. Made a complete and careful examination of all the terms and conditions in the NIT document. 

c. Received all relevant information required from MSTC. 

d. Accepted the risk of inadequacy, error or mistake in the information provided in the Bid or furnished 

by or on behalf of MSTC. 

e. Satisfied about all matters, things and information necessary and required for submitting an informed 

Bid and performance of all its obligations under there. 

f. Acknowledged that it does not have a conflict of interest. 

g. Agreed to be bound by the undertakings provided by it under the terms hereof. 

h. MSTC shall not be liable for any omission, mistake or error in respect of any of the above or on 

account of any matter or thing arising out of or concerning or relating to NIT or the selection process 

including error or mistake therein or in any information or data given by MSTC. 

 

4.8.Arbitration 

 
In the event of any dispute or difference relating to the interpretation and application of the provisions of the 

contracts, such dispute or difference shall be refereed by either party for arbitration by a sole Arbitrator to 

be appointed mutually by the parties to the contract. In case parties fail to reach a consensus in appointing 

the arbitrator, the same shall be appointed as per provisions of the Arbitration & Conciliation Act, 1996, as 

amended and rules framed there under. The language of the arbitration proceeding shall be English. The 

venue of the arbitration proceeding shall be Kolkata and costs & expenses of the arbitral proceedings shall 

be borne equally by the parties. The award of the Sole Arbitrator shall be final & binding on parties.  

 

 

4.9.Debarring Provisions:  
 

The tenderer will be debarred from getting, in future, the GST audit in MSTC in the following cases: 

 

a. If the tenderer obtains the appointment on the basis of false information/miss-statement. 

b. If the CA/CMA/Firm does not take up audit in terms of appointment letter. 

c. If the successful tenderer fails to maintain/ honour confidentiality and secrecy of the Company's 

data and information. 

d. If the Firm does not submit the audit report, complete in all respect in terms of appointment within 

the prescribed time limit. 
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4.10. Disputes 

 
Should any dispute as regards quality, quantity, specification, interpretations of the work order terms or 

methodology for execution of work arise, the decision of MSTC will be final and binding upon the 

tenderer. 

 

 

4.11. Jurisdiction:  

 

Disputes if any, arising out of this transaction are subject to provisions of competent court having 

jurisdiction over Kolkata. 

 

 

4.12. Environment, health and safety of the organization 
 

The job as stipulated in this enquiry should not adversely affect the environment, health and safety of the 

organization. 

 

 

4.13. Confidentiality 

 
The selected Tenderer or the employees deployed by it shall not without the written consent of MSTC, 

directly or indirectly divulge/ disclose/ circulate / deliver/ copy in any manner whatsoever to any third 

person/s, any information/ documents/ papers/ or in any other form which may  come to the Tenderer 

relating to, during or even after the performance of this contract, in any way or be communicated to the 

Tenderer or made available or accessible to the tenderer or their men, agents, principals and they are 

required to maintain utmost confidentiality with regard to any information which is obtained through each 

other or developed or obtained by each other in performance of obligations under this contract or if the 

said information is considered by MSTC to be confidential, secret or proprietary including, but not limited 

to information concerning know-how, pricing, technology etc. 

 

 

4.14. Termination 

 

MSTC reserves the right to summarily terminate the contract due to failure of the Agency to provide 

satisfactory services and/ or repeated failures to provide required services against Requisitions. In such 

cases, the Security Deposit shall be forfeited and decision of MSTC in this regard shall be final and 

binding. MSTC may at any time by giving one months’ notice may terminate the contract without any 

liability, financial or otherwise on itself. 
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SECTION 5 : DOCUMENT CHECKLIST 

 

The following documentary evidences duly signed by CA or CMA or Partner/Member of CA/CMA 

Firms/LLPs with seal and membership number should be submitted in support of the above-mentioned 

criteria: 

5.1. Proof of Registration of Partnership Firm/LLP clearly indicating the Registration date and firm 

registration number issued by Institute of Chartered Accountants of India or Institute of Cost 

Accountants of India, if applicable. 

 

5.2. Partnership Deed or communication from ICAI or other evidence clearly indicating the partners in the 

firm with their membership number and date from which they are with the firm, if applicable. 

 

5.3. Proof indicating Effective date of issue of Certificate of Practice (full time) shall be provided for 

experience of CA or CMA in case of sole proprietorship. 

 

5.4. Copy of document to establish that office premise is either on owner ship or rent basis in Kolkata. 

(Rent Agreement / Electricity Bill) 

 

5.5. Copy of appointment / Engagement letter for Audit of Listed Company/PSU/any other company 

having annual turnover of Rs. 500 Cr and above indicating engagement of the CA or CMA or 

CA/CMA Firms/LLPs as GST Auditor in the company for the Financial Year 2017-18 or 2018-19. 

 

5.6. GST Registration Certificate of the CA/CMA/Firm/LLP. 

 

5.7. PAN Card of CA or CMA in case of proprietorship or of Firms/LLPs 

 

5.8. Bank Mandate form and cancelled cheque for remittance of payment though NEFT/RTGS. 

 

5.9. Letter of Undertaking in Annexure I 
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ANNEXURE –I 

Letter of Undertaking 
(On letter-head of Firm/Proprietorship) 

 
To 

MSTC Limited 

225-C, AJC BOSE ROAD 

KOLKATA – 700020 

India 

 

Dear Sir, 

 

Sub : Tender No. ________________  dated __________ 

 

1. Having examined the Bid Documents including Addenda/Corrigenda, if any (insert numbers), I/We, the 

undersigned, Sole Proprietor / Partner of M/s …………………… offer to be engaged as GST Auditor 

of MSTC Limited for FY 2019-20 for 18 GST Registrations vide our offer No………………..dated 

………… in conformity with the said Tender Documents. 

2. I/We confirm to accept all terms and conditions contained in the Tender document unconditionally. 

I/We also confirm that there is no deviation in my/our submission. 

3. I/We agree to abide by this bid for a period of 60 days from the date of price bid opening and it shall 

remain binding upon me/us and may be accepted at any time before the expiration of that period. 

4. I/We confirm that until a formal appointment order is issued, this bid together with your written 

acceptance thereof and your notification of award, shall constitute a binding Contract between us. 

5. I/We understand that you are not bound to accept the any of the bid you may receive. 

6. I/We confirm that the contents of the offer are given after fully understanding and all information 

furnished by me/us are correct and true and complete in every respect. 

7. I/We confirm that all information/ documents / credentials submitted along with the offer are genuine, 

authentic, true, valid and complete in every respect. 

8. I/We confirm that if any information or document submitted is found to be false / incorrect, the said 

offer shall be considered absolutely null & void and action as deemed fit may be taken against us 

including termination of the contract and debarment as per provisions of law. 

9. I/We confirm that I/We have neither been removed from GST audit assignment from Audit of Listed 

Company/PSU during last previous year, nor have been held guilty by the ICAI Disciplinary process in 

the last 10 years. Further, I/We are not under investigation nor have been charge sheeted or punished for 

any legal default with imprisonment. ICAI means “The Institute of Chartered Accountants of India” 

&“The Institute of Cost Accountants of India”. 

10. I/We confirm that I/We are free from any disqualification under sub-section (3) or sub-section (4) of 

section 141 of the Companies Act, 2013. In addition to this, I/We have not held/not holding any 

assignment as Internal Auditor of MSTC and its Subsidiary for FY 2019-20 and as on the date of 

appointment and during the continuity of the GST Audit. 

11. I/We confirm that myself/Partner/Member of the firm is not related to Managing Director/Whole Time 

Director or part time Director of MSTC Limited within the meaning of section 2 (77) of the Companies 

Act, 2013. 

12. I/We have never been banned or delisted by any Government or Quasi-Government Agency or any 

Public Sector Undertaking. 

 

OR 

 

I/We am/are banned by the organization named “---------------------------------------” for a period of -------

------------ year/s, effective from ------------------- to ---------------. 

  

 

Dated this_______ day of ______ 2021 
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Stamp and Signature  

Name (in block letters) 

Membership No CA/CMA institute 

FRN (if applicable) 

Firm Name (if applicable)  
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ANNEXURE –II 

INTEGRITY PACT 
 

Between 

MSTC LTD, hereinafter, referred to as "MSTC", 

and 

……………………….hereinafter referred to as "The Vendor/Service Provider/Buyer" 

 

Preamble 

 

WHREAS, MSTC is acting as an agent for the purpose of disposal/sale/booking/procurement of various 

commodities;  

And 

 WHEREAS, MSTC values full compliance with all relevant laws and regulations, and the principles of 

economical use of resources, and of fairness and transparency in its relations with its Principals. 

 In pursuance, thereto, the following clauses of the Integrity Pact will be applicable and this document 

shall be deemed to be an integral part of the Agency Agreement between us. 

   

In order to achieve this goal, MSTC may seek cooperation of the renowned international Non-

Governmental Organization "Transparency International" (TI).  Following TI's national and international 

experience, MSTC may appoint an external independent Monitor who will monitor the tender/auction/e-

auction/e-sale/e-booking process and the execution of the contract for compliance with the principles 

mentioned above. 

          IP-2 

Section - 1 Commitments of MSTC 
MSTC commits itself to take all measures necessary to prevent corruption and to observe the following 

principles :- 

a)  No employee of MSTC, personally or through family members, will in connection with the 

tender for, or the execution of a contract demand, take a promise for or accept, for him/herself 

or third person, any material or immaterial benefit which he/she is not legally entitled to. 

b)  MSTC will,  during the  tender/auction/e-auction/e-sale/e-booking process, provide to all 

Buyer(s)/Vendor(s) the same information and will not provide to any Buyer/Vendor 

confidential/additional information through which the Buyer/Vendor could obtain an 

advantage in relation to the tender/auction/e-auction/e-sale/e-booking process or the contract 

execution. 

c)  MSTC will exclude from the process all known prejudiced persons. 

If MSTC obtains information on the conduct of any of its employees which is a criminal offence under the 

relevant Anti-Corruption Laws of India, or if there be a substantive suspicion in this regard, MSTC will 

inform its Vigilance Office and in addition can initiate disciplinary actions. 

Section - 2 Commitments of the Buyer/Vendor 
  

The Buyer/Vendor commits himself to take all measures necessary to prevent corruption.  He commits 

himself to observe the following principles during his participation in the tender/auction/e-auction/e-sale/e-

booking/e-procurement process and during the contract execution. 

          IP-2 

i)  The Buyer/Vendor will not, directly or through any other person or firm, offer, promise or give to 

MSTC, to any of MSTC's employees involved in the tender/auction/e-auction/e-sale/e-booking 

process or the execution of the contract or any third person any material or immaterial benefit 

which he/she is not legally entitled to, in order to obtain in exchange an advantage during the 

tender process or the execution of the contract. 

ii) The Buyer/Vendor will not enter with other Buyer(s) into any illegal agreement or understanding, 

whether formal or informal.  This applies in particular to prices, specifications, certifications, 

subsidiary contracts, submission or non-submission of bids or actions to restrict competitiveness. 

iii)  The Buyer/Vendor will not commit any criminal offence under the relevant Anti-Corruption 

Laws of India; further the Buyer/Vendor will not use improperly, for purposes of competition or 
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personal gain, or pass on to others, any information provided by MSTC as part of the business 

relationship, regarding plans technical proposals and business details, including information 

contained or transmitted electronically. 

iv)  The Buyer/Vendor will, when presenting his bid, disclose any and all payments he has made, is 

committed to or intends to make to agents, brokers or any other intermediaries in connection 

with the award of the contract. 

v) The Buyer/Vendor will not instigate third persons to commit offences outlined above or be an 

accessory to such offences. 

IP-2 

Section - 3 Disqualification from tender process and exclusion from future contracts 
  

If the Buyer, before contract award, has committed a serious transgression through a violation of Section 2 

above or in any other form such as to put his reliability or credibility as Buyer into question, MSTC is 

entitled to disqualify the Buyer from the tender/auction/e-auction/e-sale/e-booking process or to terminate the 

contract, if already signed, for such reason. 

i)    If the Buyer/Vendor has committed a serious transgression through a violation of Section 2 above 

such as to put his reliability or credibility into question, MSTC is entitled also to exclude the 

Buyer/Vendor from future contract award processes.  The imposition and duration of the 

exclusion will be determined by the severity of the transgression.  The severity will be 

determined by the circumstances of the case, in particular the number of transgressions, the 

position of the transgressors within the company hierarchy of the Buyer and the amount of the 

damage.  The exclusion will be imposed for a minimum of 6 months and maximum of 3 years. 

ii)      If the Buyer/Vendor can prove that he has restored/recouped the damage caused by him and has 

installed a suitable corruption prevention system, MSTC may revoke the exclusion prematurely. 

iii)     A transgression is considered to have occurred if in light of available evidence no reasonable doubt 

is possible. 

Section - 4  Compensation for Damages 
    1. If MSTC has disqualified the Buyer from the tender/auction/e-auction/e-sale/e-booking process prior 

to the award according to Section 3 above, MSTC is  

          IP-2 

entitled to demand from the Buyer liquidated damages equivalent to 3% of the value of the offer. 

    2.   If MSTC has terminated the contract according to Section 3, or if MSTC is entitled to terminate the 

contract according to Section 3, MSTC shall be entitled to demand from the Vendor liquidated 

damages equivalent to 5% of the contract value. 

  

    3.  If the Buyer/Vendor can prove that the exclusion of the Buyer from the tender/auction/e-auction/e-

sale/e-booking process or the termination of the contract after the contract award has caused no 

damage or less damage than the amount of the liquidated damages, the Buyer/Vendor has to 

compensate only the damage in the amount proved.  If MSTC can prove that the amount of the 

damage caused by the disqualification of the Buyer before contract award or the termination of the 

contract after contract award is higher than the amount of the liquidated damages, it is entitled to 

claim compensation for the higher amount of damages. 

Section - 5 Previous Transgression 

  

    1.   The Buyer declares that no previous transgressions occurred in the last 3 years with any other company 

in any country conforming to the TI approach or with any other Public Sector Enterprise in India that 

could justify his exclusion from the tender process. 

    2.   If the Buyer makes incorrect statement on this subject, he can be disqualified from the tender process 

or the contract, if already awarded, can be terminated for such reason. 

   

IP-2 

Section - 6  Equal treatment of all Buyer(s)/Vendor(s) 
  

    1.   The Buyer/Vendor undertakes to demand from all subcontractor(s) a commitment consistent with this 

Integrity Pact, and to submit it to MSTC before contract signing.  
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    2.   MSTC will enter into agreements with identical conditions as this one with all Buyer(s), Vendor(s). 

    3.   MSTC will disqualify from the tender process all Buyer(s) who do not sign this Pact or violate its 

provisions. 

Section - 7  Criminal Charges against violating Buyer(s)/Vendor(s) 

  

If MSTC obtains knowledge of conduct of a Buyer, Vendor or of an employee or a representative or an 

associate of a Buyer, Vendor which constitutes corruption, or if MSTC has substantive suspicion in this 

regard, MSTC will inform the Vigilance Office. 

Section - 8 External Independent Monitor 

  

    1.   MSTC may appoint competent and credible External Independent Monitor for this Pact.  In such case 

the task of the Monitor is to review independently and objectively, whether and to what extent the 

parties comply with the obligations under this agreement. 

    2.   The Monitor is not subject to instructions by the representatives of the parties and performs his 

functions neutrally and independently.  He reports to the Chairperson of the Board of MSTC. 

IP-2 

    3.   The Monitor has the right of access without restriction to all Project documentation of MSTC.  The 

Vendor will also grant the Monitor, upon his request and demonstration of a valid interest, unlimited 

access to his project documentation. The Monitor is under contractual obligation to treat the 

information and documents of the Buyer/Vendor with confidentiality. 

    4.   MSTC will provide to the Monitor sufficient information about all meetings among the parties related 

to the project provided as meetings could have an impact on the contractual relations between MSTC 

and the Vendor.  The parties offer to the Monitor the option to participate in such meetings. 

    5.   As soon as the Monitor notices, or believes to notice, a violation of this agreement, he will so inform 

the Management of MSTC and request the Management to discontinue or heal the violation, or to 

take other relevant action.  The Monitor can in this regard subject non-binding recommendations.  

Beyond this, the Monitor has no right to demand from the parties that they act in a specific manner, 

refrain from action or tolerate action. 

    6.   The Monitor will regularly submit a written report to the Chairperson of the Board of MSTC and, 

should the occasion arise, submit proposals for correcting problematic situations. 

    7.   If the Monitor has reported to the Chairperson of the Board a substantiated suspicion of an offence 

under relevant Anti-Corruption Laws of India, and the Chairperson has not within reasonable time, 

taken visible action to proceed against such offence or reported it to the Vigilance Office, the 

Monitor may also transmit this information directly to the Central Vigilance Commissioner, 

Government of India. 

IP-2 

Section - 9 Pact Duration 
This Pact begins when both parties have legally signed it.  It expires for the Vendor 12 months after the 

last payment under the respective contract, and for all other Buyers' 6 months after the contract has been 

awarded. 

Section - 10  Other Provisions 

    1.       This agreement is subject to Indian Law.  Place of performance and jurisdiction is the Corporate 

Office of MSTC. 

    2.       Changes and supplements as well as termination notices need to be made in writing.  Side 

agreements have not been made. 

    3.       If the Vendor is a partnership or a consortium, this agreement must be signed by all partners or 

consortium members. 

    4.    Should one or several provisions of this agreement turn out to be invalid, the   

   remainder of this agreement remains valid.  In this case, the parties will strive to come to an 

agreement to their original intentions. 

    ______________________             _____________________ 

 For MSTC              For Buyer/Vendor  

    Place  :  ___________     Witness 1  :  _________________ 

    Date    :  __________      Witness 2  :  _________________ 


